
Geological Characteristics of the 

Ernie Junior Iron-Oxide-Copper-Gold 

Ore Body, Mt Isa Inlier, North West 

Queensland. 

Thesis submitted in accordance with the requirements of the University of 
Adelaide for an Honours Degree in Geology 

Ella Sullivan 
November 2016 



 

 

Ella Sullivan  
Ernie Junior; Characteristics and Genesis 

 
 
 
 
 
GEOLOGICAL CHARACTERISTICS OF THE ERNIE JUNIOR IOCG ORE 
BODY, MT  
ISA INLIER, NW QUEENSLAND, AUSTRALIA 
 
 
RUNNING TITLE 
 
Ernie Junior; Characteristics and genesis. 
 
 
ABSTRACT 
 
The Ernest Henry Iron Oxide Copper Gold (IOCG) deposit is situated ~35km NE of 
Cloncurry, QLD in the Proterozoic Mount Isa Inlier. It is the second largest IOCG deposit 
in Australia with a pre-mining resource of 167 Mt @ 1.1% Cu and 0.54 ppm Au). The 
‘Ernie Junior’ orebody exists between Ernest Henry and the bounding Footwall Shear  
Zone. This study presents the first characterisation and genetic model for the Ernie 
Junior ore body. Core logging, petrology, SEM, MLA and 3D modelling are undertaken 
on representative samples. The Ernie Junior ore body is hosted within a meta-volcanic 
sequence of fractured and clast-supported breccias. Host rocks have been subject to 1) 
regional albite alteration, 2) localised potassic alteration and 3) K-feldspar alteration 
associated with host breccias. Ore is also hosted in later stage veins where stage 3 
alteration is present. The infill ore assemblage is comprised of chalcopyrite, gold, and 
gangue minerals magnetite, calcite, quartz, titanite and barite. High intensity K-feldspar 
alteration is coincident with brittle deformation. Brecciation is not as well developed in 
Ernie Junior as it is in Ernest Henry, possibly accounting for its lower grade. Outside 
the breccia zone, foliations and replacement textures indicate ductile deformation linked 
to the Foot Wall Shear Zone. The paragenetic sequence and lateral zonation of Ernie 
Junior is comparable to that of Ernest Henry providing evidence that the two ore bodies 
are highly genetically related. Potential exists for further repetitions of Ernest Henry and 
Ernie Junior mineralisation north of the footwall shear zone and this may be a viable 
target for future near-mine exploration. 
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1. Introduction 
 
Despite the geological and economic importance of the Eastern Succession of the 

Mount Isa Inlier as host to Iron Oxide Copper Gold deposits, the variable nature of the 

mineralising system and burial under cover has meant that the genesis of these deposits 

is limited to a case-by-case understanding. 
 
Immediately adjacent to the Ernest Henry ore body (Figure 1), the Ernie Junior ore body 

contains ore grade copper and gold and elevated magnetite. As a consequence of its 

smaller interpreted extent, there have been no formal studies of this ore body. As such, 

its host rock assemblage, ore distribution, alteration phases, structural controls and 

paragenesis have not been formally addressed. Such observations and analyses are of 

fundamental importance to understanding the genesis of the Ernie Junior ore body and 

how it may be genetically related to the much larger, structurally hosted and 

geochemically zoned Ernest Henry ore body (Mark et al, 2006). In addition, 

understanding the formation of Ernie Junior has direct implications for near mine 

(brownfields) exploration and adds to the growing understanding of IOCG deposits 

within the Eastern Succession of the Mount Isa Inlier. 

 
 
IOCG deposits represent a broad range of mineral deposits, (Williams et al, 2005; 

Hitzman 2010). Lack of constraints on the nature of this deposit class creates 

complexity for exploration, yet their large size potential (>1000 Mt) and desirable 

grades in copper and gold makes them key exploration targets (Williams et al. 2005). 

Recognised as one of the world’s most mineralised provinces, the Eastern Succession of 

the Mt Isa Inlier in Queensland hosts a diversity of IOCG deposits (Figure 2) that 

display unique characteristics and mineralising styles (Davidson, 1998). 
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Ernie Junior 
 
 
 
 
 
 
 
 
 
 
Figure 1 Image of the Ernest Henry Mine illustrating the spatial arrangement of the Ernest Henry and Ernie 
Junior ore bodies at the grade of >1.15% Cu. Open pit shell and underground workings are also pictured. 
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Figure 2. Map of the Mount Isa Inlier, illustrating the locations and styles of significant economic 
deposits, with inset map of Australia. 
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Ernest Henry (Figure 2) has been thoroughly characterised in terms of its hydrothermal 

evolution (Oliver et al, 2004; Mark et al, 2005; Mark et al, 2006, Kendrick et al, 2006), 

geochemical signature (Rusk et al, 2010), structural control (Coward, 2000) and lateral 

zonation (Cleverley et al, 2005). Epigenetic mineralisation occurs as co-enriched 

chalcopyrite and native gold within a breccia matrix (Twyerould, 1997; Ryan, 1998). As 

Ernie Junior has not yet been completely defined or formally studied, models of genesis 

for Ernest Henry will provide a reference point for understanding the genesis of Ernie 

Junior. 

 
 
1.2 Project aims 
 
This project aims to test the hypotheses that: 
 

Ernest Henry and Ernie Junior are hosted by the same Mt Fort Constantine 

Volcanics 
 

The paragenesis of alteration and mineralisation is consistent across Ernie 

Junior and Ernest Henry 
 

The distribution of mineralisation is consistent across Ernie Junior and Ernest 

Henry 
 

Deformation fabrics are consistent across the Ernie Junior and Ernest Henry 

ore bodies 
 
These hypotheses are designed to determine to what extent the Ernie Junior ore body is 

genetically associated with Ernest Henry, given its spatial proximity, and to highlight 

any differences in genesis. This research aims to help inform future exploration at the 

Ernest Henry Mine, as well as within the Eastern Succession. 
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2. REGIONAL AND LOCAL DEPOSIT GEOLOGY 
 
 
2.1 Mount Isa Inlier 
 
The Eastern Fold Belt and adjacent Kalkadoon, Leichhardt and Western Fold Belts of 

the Mount Isa Inlier (Figure 2) comprises >200,000 km2 of Proterozoic meta-

sedimentary and metavolcanics sequences. This basement sequence was intruded by 

1550 to 1500Ma I-type granites of the Williams and Naraku batholiths prior to the 1620-

1550Ma Isan Orogeny metamorphosed basement lithologies to amphibolite facies (Page 

and Sun, 1998; Foster et al, 2007). Subsequent and regionally extensive metasomatism 

preserves evidence of at least four hydrothermal events through 1610 to 1500 Ma 

(Oliver et al., 2004) and widespread Cu mineralisation within the Eastern Succession 

and wider Mt Isa Inlier (William et al. 2005). Overlying basement lithologies include 

three major, unconformable Mesozoic volcanoclastic sequences representing three 

periods of intracratonic rifting 1785 - 1650 Ma post Isan Orogeny (Page and Sun, 1998). 

 
 
 
2.2 Deposit Geology 
 
The Ernest Henry deposit is hosted in brecciated and pervasively K-feldspar altered Mount 

Fort Constantine intermediate volcanics dated at ~1740Ma (Mark et al. 2006). The ore body 

forms a pipe-like structure, dipping ~40 degrees towards the SSE that extends down plunge 

for a length >1km and is open at depth (Keys, 2008). The ore body is ~250m long, 300m 

wide and is structurally controlled by a series of sub-parallel shear zones (Mark et al. 2006). 

Economic mineralisation lies at the core of alteration zones dominated by K-feldspar in two 

main plunging lenses and divided by a zone of weak mineralisation and brecciation (Mark 

et al, 2006, Williams, 2005) known as the inter-lens (O’Brien, 
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2016). The ore assemblage is dominated by magnetite, chalcopyrite, pyrite, carbonate, 

quartz and apatite. 

 

 
Ernest Henry and Ernie Junior interpreted to be hosted within a Paleo-Mesoproterozoic 

volcano-sedimentary succession deposited in a rift environment (Porter, 2010). 

Mineralisation is hosted in rocks most analogous to Mt Fort Constantine metavolcanics 

that outcrop ~10 km from the deposit (Williams and Skirrow, 2000; Marshall and 

Oliver, 2007). These volcanics consist of andesite and dacite with lesser metabasalts 

and calc-silicate metasedimentary rocks (Porter, 2010) (Figure 3). 
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Figure 3. Diagram of interpreted lithological extents within the Ernest Henry mine. 
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2.3. Structural and geochemical setting 
 
 
2.3.1. Ernest Henry Structural Setting 
 
Ernest Henry and Ernie Junior are located on the inflection of shear zones (Figure 4). 

They trend from E-W to NE/SW orientation which has been genetically related to the 

regional syn- to late regional D3, mineralisation (Valenta, 2000; Coward, 2000; Laing, 

2003, Keys, 2008). Control on the flexure in regional structure has been attributed to 

two resistant diorite bodies to the SE and NE of the deposit (Coward, 2001). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 4. Structural setting of Ernest Henry ore body, with relation to metadiorite intrusions and 
local shear zones. Image an internal Xtrata Copper report, 
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Three ductile shear zones are identified around Ernest Henry (Error! Reference source 

not found.), though lack of continuity of fabric intensity along drill core inhibits precise 

3D geometry modelling (Mark et al, 2006). 

 
 
 
 
 
 
 
 
 
 

Structural Description Preservation within Ernest Henry 
fabric   

   

S1 Bedding-sub parallel feature Outside of the ore zone as 
  schistosity in graphitic schists 

S2 Crenulation cleavage, broadly  
 synchronous with peak Mica schists 
 amphibolite metamorphic  
 minerals.  

S3 Hetrogeneous foliation and Biotite and carbonate-rich lithologies 
 crenulation development and within and adjacent to the ore body. 
 formation of imbricate  
 breccias. Local overprinting of   

biotite-magnetite in the 
footwall rocks. 

 
Table 1. Summary of structural fabrics within and around the Ernest Henry deposit, in vicinity to Ernie 
Junior. Information reference: Mark et al, 2006. 
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The Ernest Henry deposit is bound by two shear zones - the Hanging Wall Shear Zone 

(HWSZ) and Footwall Shear Zone (FWSZ) and contains the unmineralised Interlens 

shear zone within its extent. Ernie Junior is located between Ernest Henry and the 

FWSZ in proximity to two major faults; Fault 6 and the Angry Man fault (Figure 5). 

Interpreted as post mineralisation structures, their bounding nature to the ore bodies 

indicates potential for fault displacement of mineralisation in proximity to the Ernest 

Henry Deposit (Max Ayliffe, AIG journal, 2009). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 5 . Illustrating the interpreted extent of the main structures associated with Ernest Henry 
and Ernie Junior ore bodies. Compiled using ore shells provided by Ernest Henry Mine. 
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2.3.2 Ernest Henry Geochemistry and Alteration 
 
Cu and Au within the Ernest Henry ore is strongly co-enriched at a ratio of 2:1 with 

economic mineralisation occurring as chalcopyrite and native gold (95%) and minor 

electrum (5%) (William, 2000., Rusk et al, 2010). The distribution and intensity of Cu 

and Au is displayed in Figure 6. Alteration stages and associations are displayed in 

Table 2. 

 
 
 
 

Ernest Henry 
 
 
 
 

 
Ernie Junior 

 
 
 
 
 
 

 
Ernest Henry 

 

 
Ernie Junior 

 
 
 
 
 
 

 
Ernest Henry 

 

 
Ernie Junior 

 
 
 
 
 
 
 
Figure 6. All Ernest Henry Mine (EHM) drilling and interpreted ore body shells a) Interpreted 
outlines for Ernie Junior (yellow) and Ernest Henry (grey) illustrating their relative position to the 
open cut pit. Their extent is based on a 1% Cu grade b) Copper assays for EHM illustrating the 
core of the Ernest Henry ore body and sparse drilling through Ernie Junior. Assay values are 
taken as an average grade over 2 metre intervals. c) Gold assays for EHM illustrating their spatial  
association with Cu grade. Assay data courtesy of EHM. 4 
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Alteration type Description 
Preservation within Ernest 
Henry 

   

Albite Albitisation of Fracture-related 
hydrothermal breccia,  plagioclase  

crackle veining,  phenocrysts  

pervasive alteration   

Potassic Fine grained biotite Pervasive alteration through all 
 and magnetite rich rock types, rare veining 
 alteration  

K-feldspar Equigranular fine- Pervasive alteration of 
 medium grained k- volcanic rocks, veining 
 feldspar  

 
 
 
 
 
Table 2. Summary of alteration assemblages within and around the Ernest Henry deposit, in vicinity of 
Ernie Junior. Alteration stages are ordered by interpreted evolution (Mark et al, 2006). 
 
 
 
 
 
 
2.4. Genetic Models for Ernest Henry 
 
The formation of Ernest Henry is recognised within the context of a structurally zoned, 

post-peak metamorphic hydrothermal system, synchronous with the D3 regional 

metamorphic event (Mark et al, 2004). Its regional geochemical footprint is dominated 

by regionally extensive and pervasive albitic and potassic alteration, focussed by local 

faulting (Blenkinsop and Stark, 2003). 
 
Economic copper and gold mineralisation is restricted to breccia zones with a significant 

matrix component of more than 10% (Keys, 2008) and is thought to have formed at a depth 

of 6-10km via circulation of hydrothermal fluids derived from regional ‘A’- type granites 

associated with, hydrothermal brecciation event (Kendrick and Phillips, 2006; 
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Ryan, 1998; Williams, 2005). Its genesis however is still contentious (Rusk et al, 2010) 

and previous studies have suggested a combination of magmatic (Mark et al, 2000; 

Williams and Skirrow, 2000), non-magmatic (Haynes, 2000) and a hybrid of multiple 

fluid/metal hydrothermal fluid sources (Mark et al, 2000). More recently, fluid origins 

have been attributed to a mixture of magmatic, metamorphic and basinal sources 

(Williams, 2005). 
 
Mark et al, 2006 have interpreted that mineralisation resulted from fluid mixing during 

dilation and brecciation, concentrated in areas of the initial potassic alteration. An 

alternate model of genesis attributes breccia host formation to fluid overpressure and 

explosive brecciation (Oliver, 2004). 
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3. Methods 
 
 

3.1 SAMPLING 
 

This thesis is based on fieldwork completed at the Ernest Henry Mine core yard. Drill 

core logs were produced for seven representative drill holes, within the interpreted 

extent of the Ernie Junior ore body (Figure 7). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 7. Illustrating the locations and sections of drill holes observed in this study, against the 
interpreted ore shell. Ore shells represent a 1% Cu grade. Ore shell triangulation courtesy of EHM, 2016. 
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Drill core was logged for lithology, alteration, sulphides, foliation, brecciation and vein 

abundance. HQ sized diamond drill core was logged in intervals based on lithology type 

as listed in Error! Reference source not found.The logged data for each drill hole is 

represented using a scaled interval in Adobe Illustrator and is used to observe the 

distribution of ore in relation to lithologies and alteration. 

 
 
 
 
 

Drill Hole ID Intervals logged (m) 
  

EH504 390-580 

EH644 1010-1210 

EH690 940 - 1130 

EH777 0-150 

EH728 80-400 

EH779 0-120 

EH827 0-35 
 
 
Table 3. Sections of core logged for drill holes: EH504, EH644, EH690, EH728 EH777, EH779 and 
EH827. 
 
 
 
 

 
From these drill holes, a total of 20x 15cm quarter-core samples representative of 

mineralisation, host rock, veining and alteration were selected for detailed analysis at the 

hand-sample scale. Samples were selected and cut into thin sections for petrographic 

analysis through microscopy, scanning electron microscopy (SEM) and mineral liberation 

acceleration (MLA). Fifteen thin sections were polished for reflected light analyses. The 
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remaining five samples were unpolished. Each section underwent optical microscopy to 

assess host rock petrology, ore mineralisation and paragenesis. 

 
 
 
 
 
3.2 Petrology and Ore Microscopy 
 
Twenty Ernie Junior core samples were sent to Ingham Petrographics, Ingham, 

Queensland, to produce polished thin sections. A DP21 Microscopy digital camera, 

mounted on an Olympus Bx51 System dual-purpose microscope was used to view and 

photograph thin sections, facilitating assessment of host rock petrology and ore zone 

mineralogy for establishment of Ernie Junior paragenesis. 

 
 
3.3 Scanning Electron Microscopy and Mineral Liberation Acceleration 
 
The Quanta 600 Scanning Electron Microscope (SEM) was used to analyse and describe 

mineralogy and texture. Analyses were conducted on 15 carbon-coated thin sections of 

representative Ernie Junior ore. The SEM was equipped with energy-dispersive X-ray 

spectrometer and was used to identify accessory minerals through semi-qualitative 

approximation of chemistry. Back-scattered electron (BSE) imaging was used on areas 

of interest for further textural analyses. In addition, Mineral Liberation Acceleration 

(MLA) was undertaken on BSE images in order to highlight fine-grained accessory 

phases and their distribution within samples. The MLA allowed the processing of 

colour-coded minerals based on chemical composition. Textural complexity provided a 

limitation to data collection. Limitation of the spectral database was negated by cross-

checking with petrological observations to account for any possible identification errors. 
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3.4 Assay Plots 
 
Relevant drill hole intervals from the Ernest Henry Mine database were selected in 

order to determine the ratios between copper and gold in the Ernie Junior ore body. 

Assay data provided by Ernest Henry Mine is based on the average of copper (%) and 

gold (ppm) over 2 metre intervals down drill holes. 

 
 
3.5. Structural measurements 
 
Foliation and vein measurements were taken from drill core using survey data from the 

Ernest Henry Mine and a Majoribanks Core Frame. The core frame was aligned with 

the orientation of the drill hole as it would be positioned in-situ, using a compass 

clinometer. Orientation lines indicating the base of the hole on drill core was place 

facing down on the oriented core frame. Measurements of planes were made with a 

compass clinometer as per in the field. 

 
 
3.5 3D Modelling in Vulcan 8.2 
 
Vulcan Envisage and Isis were used to model lithologies and alteration in 3D between 

studied drill holes. Databases were compiled and lithologies and alteration were colour 

coded to represent the ore body visually. Structural measurements were likewise plotted 

presenting measurements in 3D using the Vulcan Isis database complier. Positioning of 

drill holes by their Northing, Easting and Reduced Level allowed for accurate 3D 

positioning of textures and structures through the ore body. For an extended method of 

database design and 3D display refer to Appendix A. 
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4. RESULTS 
 
4.1. Cu:Au ratio 
 
Cu:Au ratios from drill holes EH690 and EH644 (which intersect both ore bodies) were 

compiled from each ore body intersection (Figure 8). Results show an R2 correlation of 

0.9 indicating a distinct positive relationship between copper and gold at a ratio of 

roughly 2:1 within Ernest Henry and Ernie Junior. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 8. Cu:Au of drill holes EH690 and EH644, intersecting both Ernie Junior and Ernest 
Henry11 ore bodies. 
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4.2 Drill Hole Logs 

Logs were produced for each drill hole to record the distribution of lithologies, 

alteration and mineralisation. Correlations were observed between K-feldspar alteration 

and peaks in Cu and Au. Variable degrees of brecciation within the k-feldspar altered 

sections and massive sulphide veins outside the k-feldspar altered breccias (0.5-10cm 

wide) correlate to elevated Cu and Au. Magnetite alteration and infill is pervasive and 

present through all drill holes. Lower magnetite abundances are observed in intensely 

K-feldspar altered volcanics (refer to section 7) and in sections where stage 1 regional 

albite alteration is observed (refer to section 8). 

The ore-bearing breccia zone in EH644 and EH960 is highly variable, with contrasting 

textural repetition of ~3 metre wide units of massive and breccias units that correspond 

to highly fluctuating Cu/Au grades, within the same lithology and alteration of FV 

volcanics. Higher matrix component is observed with higher Cu/Au elevations within 

intense areas of k-feldspar alteration. 

Intense magnetite alteration with lesser biotite is a halo to k-feldspar alteration that is 

present to the extents of drill core logged. Exceptions to this are where trachyandesite 

textures are preserved in drill hole EH777 (Figure 14), where drill core is less magnetic, 

preserving an earlier albite alteration stage. Detailed descriptions of lithologies and 

alteration stages follow below in section 6.3 and 7. 

12 



Ella Sullivan 
Ernie Junior; Controls on Genesis 

Figure 9. The correlation between lithology, alteration and enrichment of Cu and Au for drill hole EH690. Dark rock alteration, specially increased magnetite 
correlates with lower copper and gold elevations and comprises a large component of the matrix to red rock altered breccias (refer section 7). Red rock alteration 
correlates with the majority of sulphide deposition and brecciation. However, the highest elevations of Cu and Au appear to be somewhat irrespective of the 
alteration stage experienced by the volcanics. Elevations are observed in in the Felsic Volcanics 2 lithology as a breccia, Felsic Volcanics as vein hosted and within 
andesites, also vein hosted. 

13



 

 

Ella Sullivan  
Ernie Junior; Controls on Genesis 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 10. Illustrating the relationship between lithology, alteration and enrichment of Cu and Au and correlating samples. Correlations and core observations 
indicate that red rock (k-feldspar hematite) alteration and degree of brecciation, are controls on the distribution of Cu and Au. Similar to Ernest Henry ore, a 
larger matrix component and more pervasive brecciation in ie Junior correlates to high Cu and Au components. Brecciation of red rock altered volcanics and 
strong foliation of magnetite +/- biotite alteration indicates a competency contrast, related to presence and intensity of k-feldspar and hematite alteration. 
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Figure 11. The correlation between lithology, alteration and enrichment of Cu and Au for drill hole EH644. Volcanics lithologies within the red rock altered 
zone are variably brecciated, with a section from 1055-1110m alternating between breccias and massive host rocks. Massive sections are interpreted to 
correlate to the low spikes in Cu and Au abundance within this section. Interestingly, the highest ore bearing section of EH644 is within a zone that has been 
minimally red rock altered. Instead, sulphides are hosted in dark rock altered volcanics. 
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Figure 12. The correlation between lithology, alteration and enrichment of Cu and Au for drill hole EH644. 
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Figure 13. The correlation between lithology, alteration and enrichment of Cu and Au for drill hole EH779. 
Enrichment in Cu and Au is major peak in elevation observed within the Felsic Volcanics. 
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Figure 14. The correlation between lithology, alteration and enrichment of Cu and Au for drill hole EH504.  
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Figure 15. The correlation between lithology, alteration and enrichment of Cu and Au for drill hole EH827. 
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4.3 Paragenesis of mineralisation 

The  paragenesis  of  mineralisation within  Ernie  Junior,  based  on optical and  SEM 

microscopy (Figure 19). 

Figure 16. The paragenetic illustrating the sequence of the Ernie Junior mineralisation in relation 
alteration and structures events. Pre ore alteration includes albite and magnetite ± biotite alteration 
post shear zone formation. Following this, k-feldspar alteration ± hematite alteration occurs and is 
subject to brecciation through the ore phase, which in the matrix is comprised predominantly of 
carbonate, pyrite, chalcopyrite and gold. Distal expression of ore in veins away from the main ore 
breccia is observed to contain the same assemblage ± quartz. Cross-cutting quartz and calcite 
veining and alteration of biotite to chlorite also post-dates the ore phase. 
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4.4 Host Lithologies 

Characterisation of host volcanics within the Ernie Junior ore body extent indicate that 

Ernie Junior host rocks are mineralogically and texturally consistent with the 

metavolcanic sequence that host Ernest Henry ore (Figure 3). They comprise variably 

altered intermediate volcanics. Key lithological observations within and around the ore 

body are documented below. 

4.4.1 META-ANDESITES 

Meta-andesites are present as a dark-grey porphyritic/non porphyritic volcanic rock 

comprised of albite, quartz, magnetite ± biotite). Orientated albite phenocrysts define a 

trachyte texture (Figure 19,c,d). Smaller albite crystals comprise ~80% of the matrix 

and are variably preserved due to overprinting by K-feldspar (Figure 19a). Variable 

stages of K-feldspar overprinting is expressed on a continuum from light pink 

phenocrysts in an unaltered matrix, to intense K-feldspar and hematite alteration in 

which phenocrysts are just detectable in hand specimen. Spatially, these rocks are 

preserved both within and outside the ore body and do not contain elevated Cu and Au 

(refer to drill hole logs figure Figure 11 to Figure 12). 
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Figure 17. Representative images of meta-andesites in hand specimen and XPL microscopy a) 
Section of core from drill hole EH504, showing typical porphyritic section and variable 
overprinting by red k-feldspar and hematite b) Close up trachyte texture comprised of albite 
phenocrysts c) non-porphyritic andesite d) XPL image of the fine-grained groundmass meta-
andesites, comprised albite, magnetite and quartz e) Foliated and unaltered andesite in close 
proximity to k-feldspar altered veining and subsequent sulphide infill. 

4.4.2. FELSIC META-VOLCANICS 

Brecciated and variably foliated felsic volcanics comprise the major rock type of the Ernie 

Junior ore body. These rocks are fine grained, k-feldspar and quartz rich volcanics that have 

been subject to intense alteration and brecciation (Figures Figure 11-Figure 16). Less 

pervasive alteration exhibits pink altered phenocrysts of albite, interpreted as remnant 

andesite texture. Both fracturing and brecciation is common within this lithotype. 
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Felsic volcanics comprise the majority of the ore bearing rock and are therefore further 

subdivided based on degree of brecciation and sulphide abundance: 

Felsic Volcanics are Porphyritic/non-porhyritic massive to crackle veined volcanics 

Figure (Figure 20). Pyrite and chalcopyrite are minor components within the intensely 

K-feldspar + hematite lithotype. This lithotype is recognised by the EHM mine 

personnel as low-grade ore and waste rock (Internal report, EHM, 2009). 

Figure 18. Representative hand specimens of Felsic Volcanics a) Core image from EH644 
illustrating the massive texture of this lithology that exhibits magnetite alteration between more 
intensely altered sections b) Close up hand sample of the felsic volcanics illustrating a pre-breccia 
texture which is host to minor sulphides. 
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Felsic Volcanics 1 display tension vein and moderate brecciation (Figure 21). The FV1 

(ref. Ernest Henry lithologies in Figure 3) unit within Ernie Junior is comprised of small 

(up to 10mm) carbonate veins within a red rock altered matrix. This texture, recognised 

as a sub-parallel feature to shearing within the Ernest Henry ore body (Taylor, 2009) is 

observed towards the south east of the Ernie Junior ore body within drill holes EH644 

and EH777. 

Figure 19. Representative FV1 tension veining a) ‘seagull’ veining of calcite in a variably 
but pervasively altered magnetite and k-feldspar matrix b) the same texture, but with a 
higher magnetite component, illustrating a variable overprint of magnetite alteration. 
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Felsic volcanics 2 are comprised of FV clasts within a matrix of calcite +/- magnetite +/-

pyrite +/- chalcopyrite +/- biotite +/- chlorite and are distinguished from the other two felsic 

volcanics by a more matrix supported nature (Figure 25). This lithology is observed as a 

minor component of the drill core studied. Within Ernie Junior, both mineralised and non-

mineralised matrix supported breccias are observed. This differs from the matrix supported 

breccias that comprise the high grade ore zone within Ernest Henry. 

Figure 20. FV2 lithology characterised by development of a higher matrix component a) Illustrates 
FV2 in drill core, where the matrix is comprised of calcite and magnetite b) Illustrates a less 
developed FV2 matrix also comprised of calcite and magnetite c) Hand specimen sample of FV2 
illustrating an unmineralised matrix supported breccia d) Mineralised sample of FV2 illustrating 
disseminated sulphides throughout the matrix of the drill core. 

4.4.4 Meta-intermediate volcanics 

Massive unit, with moderate-strong foliation defined by biotite and magnetite is 

observed outside the K-feldspar and andesite lithologies, in proximity to the FWSZ. 

This un-mineralised unit is comprised of magnetite, biotite, and variably garnet rich 

veining that indicates abrupt transition laterally into non-foliated andesites. 

Spatially, this lithology occurs to the South East of the Ernie Junior ore body and is not 

associated with ore mineralogy as indicated in drill core logs (Figure 24). 
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Figure 21. Core specimens of intermediate-mafic volcanics observed outside the extent of Ernie 
Junior mineralisation a) Garnet with inclusions of quartz associated with magnetite alteration 
around a calcite vein, b) Pervasive carbonate wash in between highly altered clasts of porphyritic 
intermediate volcanics, c) biotite aggregates with an unidentified halo d) foliated magnetite and 
biotite with garnet veining. 

4.5. Alteration and veining 

The Ernie Junior ore body has undergone three distinct styles of alteration (Figure 24), and 

displays a complex history of alteration, producing 1) albite, 2a) magnetite ± biotite, 
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3) K-feldspar volcanic host rocks. Minor chlorite and sericitic alteration is also observed

within Ernie Junior. Core logging has indicated that K-feldspar +/- hematite is associated 

with, but not confined to, the main ore phase of Ernie Junior. Earlier phases of alteration 

exist outside the dominant ore-bearing zone that is defined by K-feldspar alteration. 

Figure 22. Relative timing of alteration in relation to the ore-bearing phase. Early albite, sericite 
and magnetite +/- biotite alteration is preserved outside the ore zone. The ore phase is mainly 
associated with brecciation of red rock altered rocks. Chlorite is observed as an alteration 
product after the second stage magnetite +/- biotite alteration as a minor phase that is also more 
present outside the ore bearing red rock altered breccias. 

27 



Ella Sullivan 
Ernie Junior; Controls on Genesis 

4.4.1 STAGE 1- ALBITE ALTERATION 

Albite alteration is observed as the albitisation of plagioclase phenocrysts and 

groundmass crystals within trachyandesites. Representative samples of the styles of 

albite alteration are summarised in Figure 25, with the overprinting of this alteration by 

K-feldspar alteration illustrated inFigure Error! Main Document Only. 

Figure 23. a) Sample EH738.2 illustrating a typical trachytic texture, preserving the earliest 
alteration preserved in immediate host sequence to Ernie Junior b) SEM image illustrating a sodic-
feldspar interpreted to be albite. Inclusions within the phenocryst indicate some textural 
destruction of albite c) Sample EH 779.2 illustrating destruction of the edges of albite phenocrysts 
d) gradient k-feldspar overprinting of trachyandesites by fabric destructive k-feldspar alteration.
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Figure 24. Illustrating the preservation of host rock trachyandesites and subsequent overprinting. The earliest stage of these volcanics is preserved as a fine-grained groundmass 
of randomly oriented albite altered as the result of early Na-Ca alteration of plagioclase. Large albite phenocrysts are more resistant to k-feldspar alteration and are preserved or 
pseudomorphed with further alteration a) Original trachyte texture comprised predominantly of albite as an alteration feature b) Sample 504.4 Albite phenocrysts being 
overprinted by magnetite +/- biotite alteration. Some albite still evident in the groundmass c) Sample 504.1, Preservation of the host rock occurs as clasts in weakly-moderately k-
feldspar + hematite alteration zones. Phenocrysts are preserved yet the groundmass has little remaining albite texture d) Sample 504.3, Remnant phenocryst within a k-feldspar 
dominated matrix, no evidence of original andesite groundmass. 
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4.4.2 STAGE 2-MAGNETITE ± BIOTITE ALTERATION 

Magnetite and biotite alteration is abundant outside Ernie Junior in proximity to the 

FWSZ and throughout the ore body where not overprinted by further K-feldspar related 

alteration. Magnetite and biotite occur variably as individual crystals or as foliated 

aggregates within both the felsic volcanic centre of the ore body and within the 

bounding footwall shear zone. Within the biotite schist, biotite occurs as elongate 

foliated round lenses from 4-60mm in length. Magnetite is pervasive as an early 

alteration product and as infill in anhedral aggregates (Figure 26). 
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Figure 25. Intense magnetite alteration outside of the ore breccia host to Ernie Junior a) intense 
magnetite and biotite alteration of what is interpreted to a porphyritic intermediate volcanic b) intense 
groundmass alteration of magnetite within a porphyritic volcanic. K-feldspar alteration has altered the 
phenocrysts in this sample to a pinky-red colour c) photomicrograph of sample EH777.3 illustrating 
intense alteration within the centre of a pre-existing clast of intermediate volcanics which has been 
nearly entirely overprinted by K-feldspar alteration d) Intense magnetite groundmass alteration 
showing the same relationships observed in ‘b’ except in this hand specimen, K-feldspar alteration has 
not completely overprinted the calcite veins present, but has instead just altered the edges. 
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4.4.3 STAGE 2B- SERICITIC ALTERATION (PRESERVED OUTSIDE ERNIE 
JUNIOR) 

Sericite is observed as a minor alteration phase, observed in association with albite 

phenocrysts, destructively replacing the crystal faces and interiors (Figure 27). Minor 

pyrite is also observed within this alteration phase. 

Figure 26. Sericitic destructively alterating albite. a) Sample EH690.2 illustrating sericite alteration 
within a fine-grained matrix of albite and quartz b) Sample EH644.4 seriticitic alteration of both 
the matrix and phenocyst of a magnetite altered andesite c) Sample EH504.4 very fine grained 
sericitis alteration illustrating its destruction of the interior of an albite phenocryst d) Sample 
EH728.c medium-grained sericite at the edges of an albite phenocryst. 
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4.4.4. STAGE-3 K-FELDSPAR RICH ALTERATION ± HEMATITE 

K-feldspar rich alterationlteration (K-feldspar with hematite dusting) represents the intense 

overprinting of magnetite +/- biotite alteration and albite bearing andesites. This alteration 

ranges from pink to intense brick red within Ernie Junior and defines the felsic volcanic 

lithologies (Figure 28). This alteration correlated strongly to the presence of elevated copper 

and gold, indicated by drill logs in Figure 11 to Figure 30 displays the intensity and distribution 

of this alteration. 

Figure 27. Hand sample, photomicrograph and MLA images illustrating the intense nature of k-feldspar rich 
alteration a) Hand specimen illustrating a clast supported breccia with stage 3 altered clasts b) sample 
EH644.2 Illustrating an increased brightness where the red is altering a previous vein texture c) Sample 
EH504.3 photomicrography of intense K-feldspar alteration of quartz crystals d) MLA image illustrating k-
feldspar in green and how pervasive this alteration is through the volcanics. 
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Figure 28. K-feldspar intensity and distribution through Ernie Junior ore body. Indicating that 
while red rock alteration is associated with a higher copper and gold content and is variable across 
the ore body. 
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4.4.5 STAGE 4- CHLORITE ALTERATION 

Chlorite alteration is a minor phase, present in felsic sections of the ore body and in 

veins that bear the ore phase mineralogy of pyrite and chalcopyrite (Figure 30c). Its 

presence is indicative of a retrograde association. Chlorite is commonly observed as the 

alteration product after biotite (Figure 30f) and varies in intensity from partial 

replacement of biotite grains, to vein hosted chlorite masses (<1mm in width) (Figure 

30a,c). Alteration is to some extent, controlled by existing grain size, (Figure 30d) and 

is abundant throughout samples 779.2 and 728.c. 

Figure 29. Illustrating late alteration of biotite by chlorite in different styles within the ore body, a) 
Sample EH Illustrating the alteration of biotite to chlorite b) Veins of chlorite cross-cutting a felsic 
volcanic clast with remnant plagioclase textures c) Chlorite replacement of infill biotite in a calcite 
vein, d) Common occurrence of biotite in felsic volcanics, as rare occurrence, spatially associated 
with magnetite within a K-feldspar and quartz matrix. 
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4.4.6 VEINING 

Calcite veining in Ernie Junior is present as breccia infill, cross-cutting veins (Figure 

31a,c,d,e,f,g), ‘tension’ style veining and a carbonate wash. Calcite dominates breccia 

infill where it has not been subsequently replaced by magnetite, pyrite, chalcopyrite, 

biotite ± barite ± titanite. Cross-cutting calcite veins are evident in un-brecciated 

volcanics with both K-feldspar and magnetite ± biotite alteration (Figure 31f) but are 

rarely observed to intersect ore breccias. 

Figure 30. Vein styles across the Ernie Junior ore body. a) cross-cutting calcite vein in highly 
magnetite altered host rock. K-feldspar alteration at the edges indicating a second flux of fluid 
through the vein, b) pre-breccia style veining with infill of pyrite, chalcopyrite, calcite and 
quartz, c) medium veins of quartz + calcite, hosting ore phase mineralisation, d) offsetting calcite 
and quartz veins with infill of magnetite e) representative sample of fine-grained calcite veining 
which does not display infill mineralisation f) K-feldspar alteration of a vein and subsequent infill 
of the ore phase. K-feldspar alteration permeates out of the vein into the surrounding volcanics. 
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4.4.7 Quartz Veining 

Quartz veining occurs as fine-coarse randomly oriented veins that crosscut the 

mineralisation assemblage (Figure 31d), or as discontinuous aggregates of interlocking, 

mosaic grains with calcite (Figure 31c). Quartz is also present as inclusions in garnet 

within the metasediments/mafic FWSZ lithology. This minor veining style not 

associated with the ore phase. 

4.5. Ore minerals and associations 

The ore phase of Ernie Junior comprises chalcopyrite, pyrite, magnetite and calcite ± 

titanite ± barite as infill within breccias and veins in the following paragenetic sequence: 

Figure 31. Paragenetic sequence of ore deposition involving veins and matrix components. Calcite 
forms selvedges most predominantly in felsic volcanic lithologies. Pyrite infills and fractures, 
providing subsequent space for infill magnetite and chalcopyrite. 

Copper within Ernie Junior is present as anhedral grains of chalcopyrite. Chalcopyrite as 

infill exhibits finer grains than in veins (Figure 33). Chalcopyrite is highly associated with 

pyrite and magnetite; the three nearly always coexisting except where the ore phase is 

replacing a fine-grained assemblage in a breccia matrix. Where not associated with pyrite, 
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chalcopyrite occurs as small grains in the matrix of predominantly felsic volcanics in 

association with magnetite, though minor amounts are hosted within stage 2- magnetite 

and biotite altered rocks. 

Pyrite is strongly associated with chalcopyrite and exists as euhedral-anhedral grains 

ranging from fine-grained in matrix and medium-large grains within veins Figure 33. 

Pyrite in Ernie Junior displays variable fracturing with most exhibiting minimal-

extreme fracturing (most common and as infill veining) suggesting movement post-

deposition. Fractures in pyrite provide infill space for chalcopyrite and other minerals 

Figure 33. Vein-hosted pyrite grains are up to 4mm across. Non-foliated samples lack 

the fracturing in pyrite seen in foliated samples. 

Gold was not observed under petrographic and SEM analysis .The presence of gold 

within the drill core studied was determined via assays from the EHM database. Refer 

to drill logs (Figure 11 to ). 

4.6. Ernie Junior Ore Styles 

Two styles of ore deposition are recognised within Ernie Junior, each comprising an 

assemblage of chalcopyrite in association with pyrite, magnetite, calcite, +/- biotite +/-

chlorite. Chalcopyrite mineralisation occurs 1) matrix hosted- within brecciated felsic 

volcanics 2) vein hosted- as replacement of late stage calcite +/- quartz veins that 

crosscut all other textures. Textural variation in ore deposition is shown in Figure 8. 

Comparable assemblages and lack of cross-cutting ore styles indicate that their 

deposition is synchronous. 
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4.6.1 Matrix hosted 

Breccia hosted ore occurs almost exclusively within the felsic volcanic lithotypes. 

Brecciation of felsic volcanic clasts is infilled with an assemblage of calcite, 

chalcopyrite, pyrite and magnetite with lesser quartz, biotite and titanate. 

4.6.2 Vein Hosted 

Vein-hosted ore is observed as an ore phase that exists outside the breccia extents. 

Present in more competent volcanics irrespective of host rock alteration. 1cm-10cm 

calcite veins host chalcopyrite, and pyrite as larger grains than is observed in matrix 

breccias (Figure 33 a,c,e). 
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Figure 32. Photomicrographs of vein and matrix hosted ore phases illustrating the difference between the two 
styles of ore deposition. a) Sample 504.4 under XP and reflected light illustrating vein hosted chalcopyrite in-filling 
around a fractured grain of pyrite. b) Sample 644.3 under reflected light illustrating matrix hosted anhedral 
grains of chalcopyrite, exhibiting smaller crystal sizes compared with vein hosted crystals and a close association 
with magnetite. In comparison to a and c, matrix hosted pyrite displays a lesser degree of fracturing. c) Sample 
644.2 under XP and reflected light illustrating micro-fracturing in pyrite and infill chalcopyrite within a carbonate 
vein. d) Sample 728.C under reflected light illustrating fine-grained chalcopyrite in a k-feldspar matrix. e) Sample 
777.3 under XP and reflected light illustrating the close association of magnetite and chalcopyrite in vein-hosted 
ore. Unlike a and c, Pyrite in this sample is not fractured. 
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4.7. Accessory Mineralogy 

SEM analysis indicates the presence of matrix supported barite and titanite as part of the 

infill assemblages. While titanite appears to be suspended in the k-feldspar matrix, 

barite is observed as late stage veining (Figure 34a) and infill (Figure 34c,d). Textural 

associations indicate that they are present as matrix hosted (Figure 35). 

Figure 33. Ernie Junior accessory phase minerals like Ernest Henry, the Ernie Junior ore body is 
rich in late stage barite (as in Mark et al, 2006) and titanite as lesser phases that comprise the ore 
body’s geochemical signature a) Sample 504-1 late stage fine barite veining within the matrix of 
k-feldspar at b) Sample 728.c displaying titanite grain and k- feldspar with unidentified alteration 
edges c) Sample 728.c displaying fractured barite infilling fractures in pyrite d) Sample 728.c 
displaying large fractured barite grain with disseminations through the quartz and k-feldspar 
matrix. 
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Figure 34. Spatial association of accessory titantie within the matrix of a clast supported 
breccia. Titanite (bright green) is finely distributed in the matrix of sample 644.3. 
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4.8. Textural variation and structural control 

4.8.1 BRECCIA TEXTURES AND VARIATION 

Ernie Junior exhibits variable textures both within the felsic volcanic and dark rock 

altered lithologies, evident of brecciation (Figure 36a-e) and shearing (Figure 36 f). 

SEM and MLA analysis provides further distinction between quartz and K-feldspar 

(Figure 36e and f). 

Figure 35. Illustrating breccia styles across the ore body. a) Felsic volcanic 1, dark rock altered 
matrix with calcite veining also present b) Clast supported breccia without sulphides c) Phenocryst 
rich clasts within a highly hematite dusted matrix of felsic volcanic clasts sulphides are confined to 
the matrix. d) Matrix supported breccia, with pervasive red rock alteration of clasts 3-15 mm in 
size. Matrix comprised of calcite veining and dark rock alteration. e) Clast supported breccia with 
magnetite and pyrite infill f) shear texture observed within a fractured quartz vein g) alignment of 
magnetite and quartz within moderate foliation with a background matrix of K-feldspar.  

g 

42 



Ella Sullivan 
Ernie Junior; Controls on Genesis 

The most common texture within the felsic volcanic ore dominated zone, is a clast-

supported breccia comprised of subangular-rounded clasts suspended in a matrix of 

calcite +/- magnetite +/- biotite +/- pyrite +/- chalcopyrite. Clasts exhibit very fine-

grained equigranular mosaic textures. Only minor matrix supported brecciation is 

recognised. Clast sizes range from 2mm to 20cm across and are rounded-angular in 

nature (Figure 36d,e). Red rock altered breccias contain calcite, magnetite, pyrite and 

chalcopyrite whereas magnetite alteration dominated breccias display this same infill 

except with rare pyrite + chalcopyrite. 

4.8.2 Structural controls 

Ernie Junior is situated between the FWSZ that bounds its lower extent and carbonate vein 

rich altered andesites within its upper extent. Foliation and vein orientations were measured 

and presented in stereonets for drill holes that had survey information available and were 

oriented. These orientations are compared with existing FWSZ structural measurements 

carried out by Tywerould, 1997 and the Interlens (O’Brien, 2016) (Figure 38). Results 

indicate a variable but general trend in dip between the SE-E consistent with both the 

FWSZ and the Interlens Shear Zone. Dips display variation from shallow to sub-vertical (10 

-88 degrees). Vein data, though limited, does not appear to follow a consistent trend. For a 

complete list of measurements refer to Appendix D. 
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Figure 36. Structural measurements of foliation and veins, plotted as poles to planes, with 
comparisons to the footwall shear zone and Interlens shear zones. Comparisons illustrate a 
common SE trending dip. Variation is present between drill holes EH728 and EH690 dip to the SE, 
EH644 dips more to the East and EH644 trending more the SW. 
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Spatial distribution of structural textures was logged and displayed in 3D using Vulcan. 

Distributions in Figure 39 highlights vertical textural change throughout the ore from 

predominantly foliations/replacement textures of foliations at the bottom bounds of 

mineralisation, to clast and matrix supported breccias in the central area, leading to 

tension veining in more massive units towards the top extent of the ore body. This may 

account for the variation in foliation textures as discussed above. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 37. Spatial variation of brecciation, tension style veining and replacement along existing 
foliation. 
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Replacement textures identified within andesitic sections of EH504 and EH777 (refer 

drill logs and Figure 40) indicate that despite the apparent competency contrast between 

the footwall shear zone and the breccias, some of k-feldspar alteration textures, veining 

and subsequent sulphides exists due to the replacement of foliation textures which pre-

date k-feldspar alteration. Spatially, these textures are preserved in porphyritic sections 

of EH504 and EH777 and are comprised of albite (Figure 39a,b). These phenocrysts 

display strong alignment but are not deformed indicating that they post-dated a previous 

foliation. Replacement phenocrysts are overprinted by k-feldspar alteration and later 

sulphides-bearing veins that preferentially permeate along these pre-existing foliations, 

indicating structural control of the peripheral extents of k-feldspar alteration. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 38. Replacement textures providing pathways for alteration and vein permeation a) Red 
rock alteration and ore phase magnetite and sulphides altering the spaces between replacement 
albite which is aligned in a foliation/shear fabric b) Replacement albite textures vein infilled by fine 
veins, infilled completely by magnetite and pyrite c) Core section of EH777 indicating the variable 

nature of the K-feldspar overprint in this section and the vein hosted nature of veins where K- 
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5. Discussion

Results from drill core logging and petrological observations indicate that Ernie Junior 

is situated within the same altered host felsic and intermediate volcanics that host Ernest 

Henry. The main alteration stages observed at Ernest Henry are also observed within 

Ernie Junior, an exception to this being the presence of chlorite alteration, which is 

confined only to Ernie Junior. In both ore bodies, correlation between mineralisation 

occurrence, grade and lithology is consistent, however at Ernie Junior, none of the 

mineralised veins crosscut the breccias that are observed at EH (eg. Mark et al, 2006). 

Structurally, there appears to be some control on the location of alteration and subsequent 

fine sulphide-hosted veins along foliation controlled location of albite/K-feldspar 

phenocrysts interpreted to be the result of replacement of a pre-existing existing foliation. 

These replacement textures preserved outside the ore body indicate that while the FWSZ 

bounds mineralisation, it pre-dates K-feldspar alteration and ore deposition. Structural 

control is identified in a SE-E dipping foliation fabric on either side of the ore body. 

5.1 Interpretation of lithologies 

Meta- andesites, felsic volcanics and mafic/sedimentary host rocks observed within and 

proximal to the Ernie Junior ore body correlate to observations of Ernest Henry carried out 

by Tywerould (1997) and Mark et al. (2006). Observations are consistent with the 

hypothesis that Ernie Junior and Ernest Henry are hosted within the same meta-

volcanic/sedimentary sequence that has been linked to the Mount Fort Constantine 

Volcanics (outcropping 15 km to the south) (Mark et al. 2006). The undercover nature of 

this volcanic sequence means that further extents of these lithologies within the structural 
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setting must be ascertained by additional drilling guided by geophysical magnetics. The 

felsic volcanics observed in drill holes in this study host the majority of ore; however 

they are generally clast-supported, which correlates to the outer shell of Ernest Henry 

that is concentrated around a higher >1.15% copper grade in its centre. 

 
 
 
 
 
5.2 Alteration events and distributions 
 
 
Four stages of alteration are observed in the Ernie Junior ore body (Table 4) 

 
 

Alteration Stage Distribution and extent of control of ore 
   
1) Albite Regional alteration event with no relevance, or control on 

  subsequent, more localised alteration stages. 
   

2) Potassic; (magnetite + 
Localised to Ernest Henry and Ernie Junior marking the 
extent of the 

biotite) mineralising system (Mark et al. 2006). 
   
3) K-feldspar rich Overprints stages 1 and 2 and is confined to both breccia 

  
and vein-hosted ore phases of Ernest Henry and Ernie 
Junior. This alteration 

   of albite phenocrysts is recognised as a vector towards 

  red rock alteration (Tywerould, 1997). 
   
4) Chlorite Alteration  after  biotite.  Post-ore  deposition  and 

  therefore no control on ore formation. 
    
Table 4. Distribution of alteration stages and the extent to which they focus ore-bearing mineralisation. 
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Stage 3 alteration in Ernie Junior widely overprints stage 2 magnetite and biotite that 

define foliation fabrics. K-feldspar alteration in the presence of a wider stage 2 

alteration halo is a desirable target for further exploration. Minor amounts of elevated 

copper and gold in areas of stage 2 (magnetite + biotite) alteration are observed as a 

minor phase without the presence of stage 3 (K-feldspar) alteration indicating that it 

may not be necessary for ore deposition but related more to structural rather than 

geochemical controls. Biotite/ magnetite rich andesites preserved adjacent to Ernie 

Junior ore correlate to the outer geochemical extent both within the Ernest Henry Mine 

area and wider Eastern Succession region (eg Mark et al. 2006; Williams, 2003) that 

maybe useful pathfinders to k-feldspar alteration (Twyerould, 1997). 

The paragenesis of Ernie Junior (Figure 41) is compared to that of Ernest Henry, as 

proposed by Mark, 2006. Mineralisation stages of Ernie Junior include widespread potassic, 

magnetite and K-feldspar alteration common throughout the Eastern Succession (Mark et al. 

2006; Kendrick et al, 2007). Ernie Junior follows the alteration events observed within 

Ernest Henry, further illustrating the consistency of their formation and the spatial 

arrangement in which mineralisation is observed, with minor differences. Though titanite 

and barite identified were identified under SEM key distinguishing EH minerals apatite and 

fluorite (eg. Williams et al, 2015) were not observed. 
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Figure 39. Schematic evolution breccia and vein hosted mineralisation. 1- Stage 1 alteration of albite 
phenocrysts in a porphyritic andesite. 2- Stage 2 alteration of host rock by magnetite and biotite. 3- 
Stage 3 alteration as k-feldspar overprints albite and gradually the whole rock texture in 4) where 
brecciation is initiated and infilled by calcite veins which 5) increase in size with a higher degree of 
brecciation. 6-magnetite infill is followed by subsequence sulphide deposition in 7. 

3a- calcite vein outside of the ore body extent within minor k-feldspar alteration. 3b Alteration of the 
calcite vein and intrustion of a second calcite vein phase, seperates k-feldspar alteration to the edges of 
the vein. 3c- sulphides and magnetite infill as with the breccia hosted ore. 

2a- foliation of andesites and stage two alteration of magnetite and biotite within the fabric. 2b-
replacement along foliation with albite phenocrysts providing a pathway for subsequent calcite veining. 
2c-K-feldspar alteration of calcite veining. 2d- subsequent massive sulphide style deposition within the 
small dialation of space provided by altered veins. 
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5.3 Comparison of ore styles and paragenesis 
 
 
A strong positive correlation of 0.9 between copper and gold ratios in both Ernie Junior 

and Ernest Henry was observed within two drill holes. Accepted variance of Cu:Au 

ratios between ore deposits within the Eastern Succession (Davidson, 1998) therefore 

provides evidence for a single fluid source for both deposits. While assays from only 

two drill holes were used to make this conclusion, the results are strong enough to 

indicate the commonality. 
 
The ore assemblage of Ernie Junior is comprised of chalcopyrite, gold, pyrite, magnetite, 
 
calcite, quartz, biotite chlorite titanite barite. These are also all observed at Ernest Henry 

(Mark et al, 2006). Two distinct styles of copper-gold mineralisation are present within 

Ernie Junior. 
 

1) Vein: (Massive sulphides cross cutting un-brecciated andesites and FV 

volcanics) with coarser grain sizes and 
 

2) Matrix: (FV, FV1 and FV2 lithologies) hosted – disseminated finer grain size 

Vein-hosted sulphides are interpreted to be the outer expression of alteration, through 

andesites that had not been altered to stage 3 alteration and therefore not brecciated. 
 
As both mineralisation styles exist in association with pyrite, magnetite and calcite as infill 

assemblages is likely they formed synchronously from the same mineralising fluid event. 

Further evidence of this is the fact vein-hosted ore at EJ is not observed to crosscut 

mineralised breccias. At Ernest Henry however, vein-hosted ore is observed by Mark et al, 

2006, to crosscut ore phases associated with breccias. Further Laser Ablation-Inductively 

Coupled Plasma -Mass Spectrometry (LA-ICP-MS) geochemical analysis of trace element 

composition and zonation is required to confirm this suggestion. 
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5.2 Structural control and deformation fabrics 
 
Measurements of foliations within proximity to the Ernie Junior ore body (refer to Figure 
 
10.2.2 for spatial extent of foliations) indicate a variable dip of 20-30 to the SE-ESE. 

This correlates with previous observations of the Footwall shear zone (Tywerould, 

1997), recently characterised Interlens shear (O’Brien, honours thesis, 2016) and 

overarching NW-striking, SE dipping Ernest Henry ore body (Mark et al, 2006). 

Variation the dip of foliations may be attributed to shear structure variation. Incorrect 

survey information may also account for the variation observed. 

 

 
The preservation of replacement textures within foliations is observed towards the 

outermost extent of the stage 3 K-feldspar alteration away from the central brecciation. This 

replacement: 1) is consistent with observations by Mark et al. 2006, of albite veining and 

porphyroblastic albite replacement, attributed to local overprinting the S2 fabric also 

recognised by Coward, 2001, 2) provides evidence of a texture preserved during the earliest 

stages of the hydrothermal system (observations in this study; Mark et al. 2006) as it 

displays only the first stage of alteration, and 3) provides further evidence for post-shear 

zone ore formation of both Ernest Henry (eg those observed by Mark et al. 2006; 

O’Brien, honours thesis) and the Ernie Junior. 
 
These textures provide evidence that the FWSZ formed prior to stage 2 and 3 alteration. 

They also control fine vein-hosted sulphides, due to preferential fluid pathways along in 

the form of calcite veining and subsequent alteration (Figure 40stages 2a-d) outside the 

main breccia phase. 
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Brecciation of the host to Ernie Junior is therefore likely the result of a competency 

contrast existing between stage 2 magnetite and biotite alteration observed within the 

FWSZ and texturally destructive stage 3 K-feldspar alteration. The fractured nature of K-

feldspar altered volcanics implies that they are more stress resistant/competent. Brecciation 

provides space for accommodation of mineralising fluids discussed in section. Overall, this 

indicates that Ernie Junior is strongly structurally controlled 

 
Further structural work on Ernie Junior is recommended to determine a sense of relative movement. 

This will provide comparison to the reverse, normal and strike-slip movement proposed between the 

bounding HWSZ and FWSZ to EH (Coward, 2001; Liang, 2003; Valenta, 2000) and EJ. Further 

investigation of the structural fabric of overlying meta-intermediate volcanics and minor sediments 

could help structural understanding. 

 
 
6. CONCLUSIONS 
 
This thesis represents the first formal study of the Ernie Junior IOCG deposit; 

characterisation, genesis and controls on mineralisation. The genesis of Ernie Junior 

bears commonalities with the adjacent Ernest Henry deposit, indicating formation 

within the same hydrothermal system. These two deposits are located between two pre-

existing shear zones, which have provided fluid pathways, and resulting alteration and 

ore deposition. Results indicate: 

 
 

Ernie Junior is hosted within the same variably altered volcanics as Ernest Henry. 

Both ore bodies lie at the core of intense k-feldspar alteration in brecciated Felsic 

Volcanics most likely analogous to the Mount Fort Constantine Volcanics. 
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The paragenesis of Ernie Junior mineralisation and Ernest Henry are consistent 

and largely controlled by successive alteration phases and infill of ore phase 

mineralisation in breccias, central to the most intense K-feldspar alteration. 

 

 
The ore assemblage of Ernie Junior consists of chalcopyrite, pyrite, magnetite, 

calcite, titanite, biotite and quartz typical of the Ernest Henry assemblage. Ernie 

Junior ore is observed in both veins and breccia infill. Vein-hosted ore is 

peripheral to breccia hosted ore, but given common assemblages, is likely 

synchronous. Stages 1) (albite), 2) (potassic, magnetite and biotite) and 3) K-

feldspar alteration identified in this study are also typical of Ernest Henry. 

 
Deformation fabrics are consistent across Ernie Junior and Ernest Henry ore 

bodies indicating commonly oriented structural control within bounding FWSZ 

and HWSZ. SE-ESE dipping, NE striking foliations in Ernie Junior and 

replacement by albite indicate that they formed before K-feldspar alteration and 

coincident ore bearing fluids. This supports a post-shear ore deposition model of 

genesis for both Ernie Junior and Ernest Henry. 
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APPENDIX A: EXTENDED METHODS 
 
3D Modelling Creating a Vulcan Isis Database for Figures 27 and 37.  Steps as per 
the Introduction to Vulcan Training Manual Version 8.2 (2012). 
 
PART A) CREATING A NEW DATABASE 

1) Open Vulcan Envisage and Isis  
2) To create a new design click File > New Design. Click Attributes to define a 

database Type. Select Drilling and choose a Desurvey style.  
3) To create a table with collar, assay, survey and geology data, click Table > 

Insert or Table > Append.  
4) Each table corresponds with columns of data in .csv files containing drilling 

information. Name each field and select text or integer depending on the type of 
data stored in each field of collar, assay, survey and geology.  

5) A key field must be defined to tell the database which field ties data across all 
tables together. To define the Key Field, right click the gray area to the left of 
the field name and select Primary Key.  

6) After the primary key is defined, click File > Save and close Isis.  
7) Open Vulcan Envisage in the primary window and click File > Import to 

import the database into the viewable field. Select CSV(Databases) and OK.  
8) Specify the data file extension, the rows which contain field names in the .csv 

and the row where records start. Click Select to choose a design file.  
9) Click File > Import and define fields so that the fields in the dialogue box match 

the table fields created in Isis. 
 
 
PART B) CREATING A LEDGEND AND VIEWING DATA 
Before you can view the database, a colour legend needs to be defined.  

10) Click Analyse > Legend Edit > Legend editor. 
11) Under DRILL, double-click [*] New legend to create a new drill legend  
12) Select Numeric and check Use database to populate drop menus and select 

the name of the database you created.  
13) Check Specify Record and Depth fields. Select a Record (Table) name, such 

as ALTERATION. Select K-feldspar alteration as the Field Name and TO as 
the To field.  

14) Check Use From or Thickness. Choose Use From and select FROM from the 
drop down list.  

15) Click Get Range to automatically populate the Colour Ranges pane with values 
from the database. You will need to select a respresentative colour for each 
interval. If a colour is not chosen for an interval, the interval will not display in 
Envisage.  

16) Check Use Colour for non-logged intervals and choose a colour which will be 
used to draw intervals in Envisage when no interval is logged in Isis.  

17) Save the legend  
18) Display the Drill holes using your new legend by clicking Geology > Drilling > 

Load drill holes and selecting your file name created in Part A. 
 
 
Extended MLA setup and processing instructions 
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1) Run the MLA process, following steps on the  
2) Verify mineral identification by the MLA using the SEM to spot check and 

assess the spectral response of the minerals.  
3) Repeat until satisfied that the mineral suite is complete. 

 
Limitations: 

1) complex textures difficult to identify  
2) the chemical similarity between mineral chemistries, and limitation of the 

spectral database, however this can be mediated by optical and SEM 
observations to fill gaps. 
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APPENDIX B: SAMPLE LIST 
 

Appendix A: Sample List - Documentation of sample locations and analyses performed on each sample. Hand specimen observations 
were conducted for all samples. Further analyses were undertaken on samples selected for thin sections. Further detail of observations of 
listed samples are located in Appendix Two or Three. 

 
    Drillhole    Scanning Mineral 
       Electron Liberation  

Sample Depth 
 

Location Location Taken to Thin Hole ID Reason for sample/brief description Microscope Acceleration Number (m) Nrth/East Collected Adelaide Section   (SEM) (MLA)         

   Shows vein alteration, cross-cutting matrix of 39084.891/ 
EHM Core 

    

EH504 504.1 396.4 altered volcanics. Representative of red-rock 39084.891 Yes Yes Yes Yes Shed    alteration in EH504.      
         

   Shear fabric with pervasive carbonate veining 39084.891/ EHM Core     
EH504 504.2 431.2 39084.891 Yes Yes Yes  

and k-feldspar alteration. Shed  
        
          

    39084.891/ EHM Core     
EH504 504.3 505.4 K-feldspar, calcite and biotite alteration. 39084.891 Yes Yes Yes  

Shed  
         
          

   Foliated sample, k-feldspar alteration of late 39084.891/ EHM Core     
EH504 504.4 525 39084.891 Yes Yes Yes  

stage veining. Shed  
        
          

    39084.891/ EHM Core     
EH504 504.5 543.2 Presence of garnet, for use with paragenesis. 39084.891 Yes    

Shed    
         
          

   Movement of late stage mineralised calcite 39084.891/ EHM Core     
EH504 504.6 539 39084.891 Yes Yes Yes  

vein. Shed  
        
          

    39084.891/ EHM Core     
EH504 507.7 554.7 Unknown alteration, albite? 39084.891 Yes    

Shed    
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EH777 777.1 3.2 Identification of green mineral. Amphibole? 38879.664/ EHM Core Yes    
38879.664 Shed    

        

Hole Sample Depth Brief Description Drillhole Location Taken to Thin Scanning Mineral 
 Number   Location Collected Adelaide section Electron Liberation 
        Microscope Acceleration 
        (SEM) (MLA) 

EH777 777.2 7.8 Shows quartz inclusions in garnet and 38879.664/ EHM Core Yes    
   pervasive veining in biotite/magnetite 38879.664 Shed     
   alteration.       

EH777 777.3 73.7 Infill of green chlorite/amphibole. 38879.664/ EHM Core Yes Yes Yes  
    38879.664 Shed     
          

EH777 777.4 91.5 Foliated sample with magnetite veins cross- 38879.664/ EHM Core Yes    
   cutting k-feldspar altered veins. 38879.664 Shed     
          

EH777 777.5 107.6 Identification of phenocryss in dark altered 38879.664/ EHM Core Yes    
   rock. Py and chalcopyrite in k-feldspar altered 38879.664 Shed     
   veins.       

EH777 777.6 112.6 Dark alteration with lighter veining containing 38879.664/ EHM Core Yes    
   magnetite. Process of alteration? 38879.664 Shed     
          

EH777 777.7 142 Displays the relationship of alteration of 38879.664/ EHM Core Yes    
   magnetite, k-feldspar, biotite and quartz 38879.664 Shed     
   veining.       

EH728 728. A 89.6  39025.82/ EHM Core Yes    
    69347.029 Shed     

EH728 728.2 126  39025.82/ EHM Core Yes Yes Yes  
    69347.029 Shed     

EH728 728.B 134  39025.82/ EHM Core Yes    
    69347.029 Yard     

EH728 728.4 177  39025.82/ EHM Core Yes    
    69347.029 Yard     

EH728 728.C 199  39025.82/ EHM Core Yes Yes Yes  
    69347.029 Yard     
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EH728 728. D 328  39025.82/ EHM Core Yes    
    69347.029 Yard     

EH728 728. E 408  39025.82/ EHM Core Yes    
    69347.029 Yard     

Hole Sample Depth Brief Description Drillhole Location Taken to Thin Scanning Mineral 
 Number   Location Collected Adelaide section Electron Liberation 
        Microscope Acceleration 
        (SEM) (MLA) 

EH644 644.1 1026.5 Mineralisation evident at the start of hole. 38304.85/ EHM Core Yes Yes Yes  
   Means for comparison to deeper Cu/Au. 69378.08 Yard     

EH644 644.2 1062.5 Typical matrix supported breccia with calcite 38304.85/ EHM Core Yes Yes Yes  
   infill, with absence on mineralisation. 69378.08 Yard     

EH644 644.3 1123 Mineralised sample, slight foliation and pink 38304.85/ EHM Core Yes Yes Yes  
   clasts..less k-feldspar altered? 69378.08 Yard     

EH644 644.4 1123 Sheared fabric, identification of banded 38304.85/ EHM Core Yes Yes Yes Yes 
   appearance components required. 69378.08 Yard     

EH644 644.5 1204 Shows relationships of shearing to clasts 38304.85/ EHM Core Yes Yes Yes  
   displaying white phenocrysts. 69378.08 Yard     

EH644 644.6 1213.5 Mineralisation in dark altered rock, unusual 38304.85/ EHM Core Yes Yes Yes  
   but present. 69378.08 Yard     

EH690 690.1 1063.1  38312.654/ EHM Core Yes Yes Yes  
    69411.904 Yard     

EH690 690.2 1112  38312.654/ EHM Core Yes Yes Yes  
    69411.904 Yard     

EH690 690.3 1115  38312.654/ EHM Core Yes Yes Yes  
    69411.904 Yard     

EH690 690.4 1150  38312.654/ EHM Core Yes Yes Yes  
    69411.904 Yard     

EH690 690.5 1156  38312.654/ EHM Core Yes Yes Yes  
    69411.904 Yard     

EH690 690.6 1055.8  38312.654/ EHM Core Yes Yes Yes  
    69411.904 Yard     
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EH779 
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APPENDIX C: PETROLOGY 
 
Appendix B: Petrology- Petrological and hand specimen observations 
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Observations  
Rich in biotite and magnetite alteration. Minor sulphides are present. Clasts of volcanics 
in the richly altered matrix. Infill of magnetite and pyrite in the calcite vein. 
 
Interpretations 
Foliations of clasts between magnetite and biotite alteation. 
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Observations  
Rich in biotite and magnetite alteration. Minor sulphides are present. Clasts of volcanics 
in the richly altered matrix. Infill of magnetite and pyrite in the calcite vein. 
 
Interpretations 
Foliations of clasts between magnetite and biotite alteration. 
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Observations  
Intense alteration of phenocrysts by sericite and K-feldspar alteration in a highly 
magnetite altered matrix. 
 
Interpretations  
Albite phenocrysts are targeted by k-feldspar alteration before it overprints the whole 
groundmass observed closer to the ore body. 
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Observations  
This sample is a matrix supported breccia. Clasts range in width from 2mm-3.5cm across and display a 
dark-pinky red colour. Within these clasts, are variable, with a lighter pink colouration. The clasts have a 
rounded appearance to them. Disseminated sulphides sit within the matrix of the rock. Larger pyrite 
grains have an irregular shape.  
The matrix is comprised predominately of magnetite. The matrix consists of a darker alteration colour, its hard 
to determine at the hand specimen scale as to whether this is very fine-grained disseminated magnetite. 
 
Interpretations  
Hematite alteration has affected the clasts, which may have already had some very fine veining through 
them, explaining the lighter pink colour within the clasts. Magnetite, once again in the matrix may be the 
result of overprinting of calcite veining.  
The larger pyrite grains may be a cluster of smaller grains that have grown in proximity to each other. 
Chalcopyrite distribution will need to be undertaken at the thin section level. 
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Observations  
Fine- grained matrix of k-feldspar with magnetite minor magnetite, pyrite and 
chalcopyrite. 
 
Interpretations 
Variable alteration but not brecciation outside the intensely k-feldspar alteration zone. 
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Observations  
Fine- grained matrix of k-feldspar with magnetite minor magnetite, pyrite and 
chalcopyrite. 
 
Interpretations 
Infill assemblage is representative of the ore bearing phase. 
 
 
 
 
 
 

76 



 

 

Ella Sullivan  
Ernie Junior; Controls on Genesis 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Observations  
Fine- grained matrix of k-feldspar with magnetite minor magnetite, pyrite and 
chalcopyrite. Both sulphides and k-feldspar alteration dominated around veins. 
 
Interpretations 
Variable alteration but not brecciation outside the intensely k-feldspar alteration zone. 
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Observations Magnetite and sulphides in calcite veins. Dark clasts 
Some quartz crystals inside the calcite veining and pink minerals. 
Calcite veining is pervasive and vary from 1- 8mm in width. 
 
Interpretations 
Where does the biotite come in? 
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APPENDIX D: STRUCTURAL MEASUREMENTS 
 

Appendix D: Raw Structural Data and strike conversions. 
 
 
  Foliations   Veins   

Hole ID Depth (m) Dip Dip Direction Converted strike value Hole ID Dip/ Direction Converted Strike Value 
504  42 146 42 504 50/220 310 
504  60 150 60 504 30/240 330 
504  80 150 80 504 20/290 380 
728  86 330 420 504 20/260 350 
728  45 115 205 504 40/295 386 
728  82 180 270 728 58/338 428 
728  75 170 260 728 48/340 430 
728  80 140 230 728 64/310 400 
728  20 190 280 728 52/90 180 
728  82 150 240 728 39/172 262 
728  78 160 250 728 59/123 213 
728  70 154 244 777 46/077 167 
728  46 136 226 777 38/056 146 
644  65 207 297 777 52/090 178 
644  50 218 308 777 40/046 136 
644  40 205 295 777 50/055 145 
644  60 275 365 777 62/017 107 
779  62 125 215 777 22/305 395 
779  38 104 194 777 10/289 379 
779  48 88 178 690 50/220 310 
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779  58 88 178 690 30/240 330 
779  69 80 170 690 20/290 380 
779  44 92 182 690 20/260 350 
779  52 90 180 690 40/296 386 
779  64 92 182  
779  56 98 188  
690  42 146 236  
690  60 150 240  
690  80 150 240  
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